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Adobe Flash es una aplicacién en forma de estudio de animacién que trabaja sobre "Fotogramas"
destinado a la produccidn y entrega de contenido interactivo para diferentes audiencias alrededor
del mundo sin importar la plataforma. Es actualmente escrito y distribuido por Adobe Systems, y
utiliza graficos vectoriales e imagenes raster, sonido, cddigo de programa, flujo de video y audio
bidireccional (el flujo de subida sélo estd disponible si se usa conjuntamente con Macromedia
Flash Communication Server). En sentido estricto, Flash es el entorno y Flash Player es el programa
de maquina virtual utilizado para ejecutar los archivos generados con Flash.

Los archivos de Flash, que tienen generalmente la extensién de archivo SWF, pueden aparecer en
una pagina web para ser vista en un navegador, o pueden ser reproducidos independientemente
por un reproductor Flash. Los archivos de Flash aparecen muy a menudo como animaciones en
paginas Web vy sitios Web multimedia, y mas recientemente Aplicaciones de Internet Ricas. Son
también ampliamente utilizados en anuncios de la web.

En versiones anteriores, Macromedia amplié a Flash mds alld de las animaciones simples,
convirtiéndolo en una herramienta de desarrollo completa, para crear principalmente elementos
multimedia e interactivos para Internet.

Fue hasta 2005 perteneciente a la empresa Macromedia conocido hasta entonces como
Macromedia Flash® y adquirido por Adobe Systems (desde entonces conocido como Adobe Flash)
ampliando con ello su portafolio de productos dentro del mercado.

EL Programa Flash fue una concepcién de Jonathan Gay, quien desarrollo la idea mientras estaba
en la universidad y lo amplié durante su trabajo para Silicon Beach Software.

En Enero de 1993, Jonathan Gay, Charlie Jackson y Michelle Welsh comenzaron una pequefia
compafiia de software llamada FutureWave Software y crearon su primer producto, SmartSketch.
Este fue disefiado para hacer graficos para computadora con lapiz, lo que hacia el proceso tan
simple como dibujar sobre papel. Este proyecto no logré ser exitoso y comenzaron a fijar su
atencidn en FutureWave y el potencial de una herrmienta para el desarrollo de un software de
animacidn vectorial para la web que compitiera con la tecnologia Shockwave de Macromedia.
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En 1995 FutureWave modifico SmartSketch agregando animacién cuadro a cuadro y los relanzaron
como Future Splash Animator. El Producto fue ofrecido a Adobe y usada por Microsoft en sus
primeros trabajos en el internet. En diciembre de 1996, Macromedia adquirié el software y lo

relanzé con el nombre de Flash contrayendo las palabras Future y Splash que componian
originalmente el nombre.
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Ejercicio 1
El Circulo que rebota

1. Creamos un documento nuevo flash Action Script 3.0.

Create New

'. Flash File [ ActionScript ggl
'. Flash File (ActionScript 210
T Fiash File (Addobe AR)

T Fiash File (Mobile)
ActionScript File

1

1| ActionScript Communication File

Flash JavaScript File

Flash Project

2. Seleccionamos la herramienta de dibujo oval.
— R

e

)| /33

[oval Toal

()

ol g
3. Dibujamos un circulo en el Stage.

&

4. Hacemos una seleccion de arrastre para seleccionar todo el circulo con la herramienta de

seleccién R

5. Ahora vamos a convertir el objeto en un Simbolo presionando la tecla F8. Es
recomendable identificar los simbolos con un nombre y no dejar symbol 1 porque luego se
confunden en la libreria.

Convert to Symbol

Name: |Circulo I | “
Type: v Reqistration: -

Folder: Library root
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6. Ubicamos nuestro objeto en el punto medio izquierdo del area de trabajo.

.‘b

7. Vamos a la Linea de Tiempo y Seleccionamos el cuadro 1

8. Cambiamos la interpolacién a Movimiento (Tween Motion) por cualquiera de los dos

métodos:

Motion Tween

Create Shape Tween k
Create Classic Tween

Insert Frame
Remove Frames

Insert Keyframe

Insert Blank Keyframe
Clear Keyframe

Convert to Keyframes
Convert bo Blank Keyframes

Cuk Frames
Copy Frames
Paste Frames
Clear Frames
Select All Frames

Zopy Mation

Paste Mation
Paste Mation Special...

Copy Mokion as ActionScript 3.0,

Reverse Frames
Synchronize Symbols

Actions

b. Menu> Insert > Motion Tween.

Modify  Text Comma
Mew Symbol... Chrl+F5

shape Tween !

Classic Tween

Timeline

Scene
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a. Boton derecho sobre el cuadro 1y en el menu contextual seleccionamos Create
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9. Como vemos automaticamente inserta una franja de fotogramas listos para animar
TIMELIME i

s @l s 1 1

10. Seleccionamos el cuadro 15 de la linea de tiempo e insertamos un keyframe por
cualquiera de los siguientes métodos:

a. Menu> Insert > Timeline > Keyframe.

Modify  Text Commands Control  De
Mew Symbol,..  Ctr4+FS

Remove Tween
Shape Tween
Classic Tween

Layer

Layer Folder

Frame FS

Blank. Keyfr!k

b. F6 =Insert Keyframe.

Trabajar con las teclas de funcién o el botén derecho del mouse ahorran mucho
tiempo, por lo que de aqui en adelante me referiré a insert KeyFrame sélo como F6.

11. Seleccionamos y verificamos que el cabezal esté sobre el cuadro 15, con la herramienta de

seleccion gg hacemos click sobre nuestro circulo y lo colocamos en la parte superior del
stage.

Podemos ver entonces que al circulo se le ha adosado una guia que muestra la trayectoria
del circulo. Cada extremo es el principio y el fin de la animacidn. Y los puntos intermedios
son la posicion del punto medio de nuestro objeto en cada uno de los fotogramas que
componen nuestra animacion.
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12. Repetimos el procedimiento de insertar keyframe en el cuadro 30= lo seleccionamos y
presionamos F6, y movemos nuestro cabezal hasta alla.
TIMELIME | MOTION EDITOR

a. Seleccionamos nuestro circulo y lo colocamos en la parte derecha del stage
13. Repetimos el procedimiento de insertar keyframe en el cuadro 45= lo seleccionamos y
presionamos F6. Seleccionamos nuestro circulo y lo colocamos en la parte inferior del
stage
14. En el Cuadro 60 insertamos un KeyFrame y hacemos que el centro del circulo regrese al
punto de partida.
a.
15. Guardamos: Menu > File > Save ¢ Ctrl +S.
16. Previsualizamos presionando Enter primero para ver la animacién en el mismo cuadro de
animacioén.
17. Visualizamos la animacidn definitiva en bucle presionando Ctrl + Enter.

Ejercicio 1
Segunda Parte - Corrigiendo el Error:

Cuando la bola regresa al cuadro 1 la cosa se complica, porque el iEmEEEsTEn o ultimo
cuadro y el primero al poseer el objeto en el mismo lugar genera un brinco
indeseado. Vamos a corregir el error.

1. Seleccionamos el Cuadro 59 e insertamos un keyframe con F6.
TIMELINE | MOTION EDITOR

s a[: 50 55 0

2. Seleccionamos el 60 solamente, para ello vamos hacer click mientras presionamos la tecla
Ctrl.

a3

3. Presionamos Shift+F5 para eliminar el key frame. Nuestro Cabezal regresa a 59 y vemos
como en el area de trabajo la pelota se posiciona justo en el punto anterior.

4. Guardamos y visualizamos.
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Ejercicio 2
El Cuadro que camina

1. Creamos un documento nuevo Action Script 3.0.

2. Seleccionamos la herramienta de rectangulo y dibujamos un cuadro fuera del stage.

N

N

A

o

3. Seleccionamos el cuadro y lo convertimos en un simbolo con F8.

4. Seleccionamos el Frame 1 del Layer 1y aplicamos la interpolaciéon de movimiento (Botén
Derecho> Crear Interpolacidon de Movimiento).

5. Seleccionamos el cuadro 60, insertamos un KeyFrame (F6), posicionamos nuestro cabezal
,seleccionamos el cuadro y lo colocamos en el otro lado del stage igualmente fuera del cuadro.

TIMELINE

Los siguiente paso debe hacerse cada vez en los cuadros 10, 30 y 50.

7. Seleccionamos el cuadro 10, 30 o 50 (Segun corresponda). Abrimos la ventana de
transformacion: Menu > Windows > Transform 6 Ctrl + T.
Verificamos que esté activa la casilla de “Constrain” lo cual hard que mantenga la proporcion
de alto por ancho.

TRAMSFORM
- 100, 0%

(=) Riotate
A onno

Conskrain
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8. Aumentamos el tamano del cuadro A 200%

TRAMSFORM

9. Repetimos en los otros cuadros indicados
10. Guardamos y visualizamos.

Ejercicio 3
La Rueda Cuadrada.

Con este ejercicio entenderemos como funciona otro tipo de interpolacion, la Cldsica. Este tipo de
interpolacion es la que se venia empleando hasta la presente version CS4 de Flash y es util para los
que tienen instalado CS3 o Anterior.

1. Creamos un documento nuevo Action Script 2.0.

2. Seleccionamos la herramienta de rectangulo y dibujamos un cuadro fuera del stage. Lko
convertimos en simbolo con F8

[]

3. Seleccionamos el Frame 1 del Layer 1y aplicamos la interpolacién clasica.

. . L, =t
4, Seleccionamos la herramienta de transformacion. ™4

5. Con pulsoy precisién, seleccionamos el pivote de rotacién (Al centro del objeto)

ke

y lo ubicamos en la esquina inferior izquierda.

el

X
6. Seleccionamos el cuadro 10 e insertamos un keyframe(F6).

Seleccionamos el cuadro con la herramienta de transformacién, ubicamos el ratén en la
esquina superior derecha ligeramente fuera del cuadro hasta que aparezca el control de

rotacion.
G-—u--—-
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7. Rotamos el cuadro a la derecha.

Seleccionamos el cuadro 11 insertamos un keyframe (F6) y desplazamos el pivote de rotacion.
J1 s 1

Bar %

| 4 W W[l

8. Repetimos el procedimiento en los cuadros 20y 21, 30 y 31 y asi sucesivamente hasta que el
cuadro salga del otro lado del Stage.

9. Guardamos y Visualizamos.

Ejercicio 4
Tween Shape

1. Creamos un archivo nuevo Action Sript 3.0

2. Dibujamos un Circulo Amarillo, sin borde. Para cambiar el color del circulo debemos hacerlo,
preferiblemente antes de dibujarlo.

a. Enlabarrade herramientas en la parte inferior podemos seleccionar amarrillo como

color de relleno .
&

b. Y nadacomo color de borde.

&£
| |

I [+coooo0 Apha: [100% - @

Estos mismos controles estdn en la ventana de propiedades al seleccionar la
herramienta de dibujo o también en la ventana de color.

3. Estavez seleccionaremos el cuadro 1y le asignaremos una interpolacién de forma (Tween
Shape).

| 5 T S T
1

Create Mation Tween

[T N
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4. Insertamos un KeyFrame en el cuadro 10 y borramos todo lo que se encuentre en el stage. La
Linea de tiempo debe lucir como sigue:

5. Ahora dibujamos un rectdngulo de cualquier otro color distinto al amarillo e incluso algun
degradado.

6. Guardamos y visualizamos.

Ejercicio 5
Llenando el cuadro

1. Creamos un Archivo nuevo ActionSript 2.0.
2. Dibujamos un pequeio circulo en la parte centro superior del Stage.
3. Seleccionamos el cuadro uno y le aplicamos Tween Shape (ver paso tres del ejercicio 4).

4. Seleccionamos el cuadro 15 insertamos un keyframe (F6) y repetimos el paso 4 del ejercicio
anterior.

5. Ahora dibujamos un cuadro del tamafio de un quinto del stage (110 x 400) esto se hace:
a. Seleccionamos la herramienta de rectdngulo.

b. Dibujamos un rectangulo, lo seleccionamos con la herramienta de seleccién y en la
ventana de propiedades le colocamos el tamafio: W:110, H:400, X:0, Y:0

|':'I-3r0peét-|es % | Filters. | Parameters

shape S
&

W 1100w 0.0

B H 4000y 0.0 %

6. En el timeline seleccionamos todos los cuadros:

a. Seleccionamos cualquier cuadro fuera de los ya seleccionados y luego arrastramos del
1al10.

b. Seleccionamos el frame 1y luego apretamos la tecla shitf y hacemos click en el 10.
7. Copiamos todos los frames. (Ejercicio 1 paso 15)
8. Insertamos un nuevo layer:

a. Menu > Insert > Timeline > Layer.
t Modify Text Commands Cortrol  Debug  Winco
Mewy Symbol...  Cirl+F8 h
Timeline Effects L3 Layer Fo[%r
Motion Guide

Scene
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10.

11.
12.
13.
14.
15.
16.
17.

18.

19.

b. Botdn derecho sobre la etiqueta del layer > Insert Layer.

: ® @01
a 7 it |

c. Botdn deinsercidn de layer en la ventana de timeline.
SR

.'nsert La':.:'e |

SCEnE

Nos paramos en el Frame 15 del layer 2 y pegamos los frames (Ctrl + Alt + V)

|_:| 1 5 10 i 20 25 3C
|, 0 >—>. |!|
e ]

Seleccionamos el cuadro 29 del layer 2 y reubicamos al cuadro en X:110

| = Properties « | Fiters | Param

Wy 1100 g 110.0

W 400.0 v, 0.0

Insertamos un nuevo layer (Layer 3) nos paramos en el cuadro 29 y pegamos los frames.

Nos paramos en el frame 43 y reubicamos el cuadro en 220.

Insertamos un nuevo layer (Layer 4) nos paramos en el cuadro 43 y pegamos los frames.

Nos paramos en el frame 57 y reubicamos el cuadro en 330.

Insertamos un nuevo layer (Layer 5) nos paramos en el cuadro 57 y pegamos los frames.

Nos paramos en el frame 71 y reubicamos el cuadro en 440.
Seleccionamos los frames 71 de los layers 1, 2,3 y 4 (dejamos el 5 libre).

Insertamos frames (OJO no son key frames) presionando F5.
i ol 65 i

Guardamos y previsualizamos.

Fin Del Dia 1. Felicitaciones. Han Aprendido a Animar en Flash.
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